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A Guide to building a Telepresence Robot 

 
A telepresence robot is a complex system with hardware and software components. It has 

mechanical and electronic components, as well as a robot firmware and a server application. This 

guide starts with a short introduction and definitions and then presents a complete guide to build 

such a robot from scratch. The software components are provided as open source projects. 

Introduction 
 

Telepresence robots are a combination of three areas i.e., robotics, teleoperation and telepresence. 

Robotics technology uses machines operated (or programmed) by humans to perform actions or 

tasks. Teleoperation involves control of a machine or framework from distances. Telepresence field 

consists of the feeling of being present for end users from both sides, who are separated by distance. 

Thus, telepresence robotics is the control of robots by the use of wireless networks or tethered 

connections virtually or at a distance [3, 4]. Telepresence robots are controlled via a tablet, laptop, 

PC or mobile phone. It consists of a screen, camera, microphones, speakers and receivers. Thus, 

telepresence robotics can empower people by giving them virtual eyes and ears while being distant 

[5, 6]. 
There are two types of telepresence robots, stationary and non-stationary. A Stationary telepresence 

robot can't be driven around by the user and is fixed in one place. The robot's head (or display) can 

be rotated to allow the user to face in any direction and better interact with by standers. 

Non-Stationary telepresence robots can be driven around by the user (shown below). This allows to 

move around on the premises, which allows for even better remote interaction with persons, 

position itself in a group or even follow someone. 

Figure 1 shows an example of such a robot. The DIY telepresence robot described in the document is 

named and referred to as ‘Telerobi’. 

 
Figure. 1: Components of a Telepresence Robot [7] 
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Telerobi Hardware Components 
Here’s a list of the mechanical and electronic components needed for assembling the Telerobi 

project. 

 

Mechanical Components 
 

Component Quantity Dimension Our Cost [€] 

Plexiglass Plates 

1 300x400x4mm 

30,2 
1 300x300x4mm 

1 300x200x4mm 

1 
Side Protectors (Reference: 
CAD-model) 

Wooden bars 2 
Total minimum Length: 1240mm 
(usually sold as 1m bars, thus 2x 1m) 

7,02 

Plastic tubes 1 
Lower tube: Ø50mm, length: 1000mm​
Upper tube: Ø40mm, length: 800mm 

2,4 

Plastic tube adapter 1 
Inner diameter: Ø40mm​
Outer diameter: Ø50mm 

1,15 

Plastic tube socket 1 Outer diameter: Ø50mm 0,49 

Curved plywood corner 
pieces 

2 100x150mmx30mm 7,5 

90-degree angle fitting 3 Used to connect Speaker Plate to tube 1,15 

2-component glue 1 Pattex 2K-Kleber Stabilit Express (30g) 9,95 

Double-sided tape 1 Transparent tesa Powerbond 7,75 

Screws 

2 M10x100mm 

10 

6 M8x60mm + wing nuts 

2 M6x70mm 

multiple smaller screws (M3/M5)  

Washers multiple div. sizes 

Nuts multiple div. sizes 

USB-to-Arduino pin power 
cable 

1 - 

Cable ties multiple div. sizes 

Tablet mount 1 TRUST Universal tablet mount 11,76 

Plastic washers 1 
Recommended by us for ​
mounting the ultrasonic sensors​
(purchase is optional) 

13.99 

Swivel castor 1 
 Height (wheel + socket): Approx. 
70mm 

3,76 
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Aluminium wheels 2  Outer diameter: Ø106mm 11,11 

 

Electronic Components 
 

Component Quantity Dimension Our Cost [€] 

Transistor 2 max.100mA 10 
 Electrical Resistors 3 1kΩ, 10k, 100Ω 

Arduino UNO WiFi 
Rev2 

1 
Check: 
https://de.rs-online.com/web/p/arduino/1
763651/  

30,84 

Arduino motor driver 
shield 

1 
Check: 
https://www.conrad.de/de/p/arduino-mot
or-shield-entwicklungsboard-1969887.html  

3,93 

DC motors 2 Modelcraft RB350050-22H22R, 6V, 50:1 19,99 

Power bank 2 
Power Bank 20800mAh, with USB output, 
5V / 2.5A 38,85 

Tablet 1 

Choose a model that fits into the tablet 
mount and is compatible with the 
telepresence software​
(e.g., Samsung Galaxy Tab A6) 

200 

Loudspeaker (optional) 1 
Hama Sonic Mobil 185 (includes two 
speaker boxes 70x70x70mm each) 

16,55 

Microphones 
(optional) 

1 
DeLock Mikrofon 65873, schwarz, 
Desktop-Mikrofon, Kugelcharakteristik 

22,93 

​
Notes on the component list:   

●​ the links are last accessed on 28.02.2023  

●​ the prices were obtained at the end of 2021 and beginning of 2022 and can strongly differ in 

future  
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Tools 
These are general suggestions. Below is the list of tools which may be useful while building a 

telepresence robot by yourself. 

1.​ Soldering Iron with Holder, used for connecting electrical components. 

2.​ Saw, used to cut precisely and remove extra material from the components of the project. 

3.​ Wire Cutters/Strippers, to remove insulation without damaging the wire. 

4.​ Multi-meter, to measure current, resistance, voltage, diode and continuity tests. 

5.​ Pincers, used for pulling or gripping objects. 

6.​ Socket wrench to tighten screws. 

 
Figure 2: left to right, multimeter, wire cutter, soldering iron with holder, pincer[8-11] 
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Telerobi Assembly 
 

 
Figure 3: Assembly steps of Telerobi 

 

Please refer the video in the link to get an idea of the assembly process instructions: 

https://www.youtube.com/watch?v=GZarpvYrOyE (9:36min to 12:17min) 
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Pre-manufacturing Process 
 

Sawing 

Step 1: Purchase wooden bars measuring 40x40x1000mm to make the wooden segments. The 
segments are supposed to be cut for assembling the rear wooden bulk for the base of the 
telepresence robot, as shown in fig.26.  
Step 2: From the purchased wooden bar (with dimensions 40x40x1000mm), saw four segments 
of wood. Two of them with a length of 320 mm (see Fig. 8) and two with a length of 300 mm 
(Fig. 8 and 9). 
Step 3: From 4 wooden segments, make 2 segments having length 320 mm each and the other 2 
segments with length 300 mm each. 
(Side Note: Remaining wood from the bars can be discarded as it will not be required for the 
robot anymore.) 
Step 2: Saw off one end of the central tube adapter piece (fig. 16) such that it fits into the lower 
tube. 
Please Note: The holes shown in fig. 6 can be drilled before or after sawing. 
 

 

Figure 4: Process of sawing wooden bars into desired segments 
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Figure 5: Process to sawing the adapter piece at one end of ring segment 

 

 

 

Drilling  

In order to put all the pieces together, holes of specific sizes need to be drilled at respective 

distances. This has to be done for the wooden pieces, plexiglass plates and plastic tube 

elements. Below are the specific instructions and technical drawings for these parts. 
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a.​ Wooden Pieces 

 

Step 1: 2x Side Segments 

 

Figure 6: Drilled holes Ø10mm each at the edges in each of the two 320mm wooden side segments. 

 

​
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Step 2: Front Segment

 
Figure 7: 2 Ø10mm holes drilled in the 40x40x300mm front wooden bulk 
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Step 3: Rear Segment 

 

Figure 8: 4 Ø10mm holes drilled in the 40x40x300mm rear wooden bulk 
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b.​ Plexiglas Plates 

Step 1: Base Plate 

 
Figure 9: Drilled holes on a 300x300x4mm plexiglas base plate 
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Step 2: Top Plate

 
Figure 10: Drilled holes on the top plate. 

Please Note: The large central hole is not drilled manually. 
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Step 3: 2x Side Protector Plates 

 
Figure 11: Dimensions of drilled holes in each of the two side protectors 

Please Note: The 2.5mm holes drilled in the side protectors are to attach the SPAX screws that 
attach the motor shaft, side protectors with the respective wooden pieces. 
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c.​ Tube elements 

Step 1: Adapter Socket 

 
 

Figure 12: Adapter Socket placed and glued in Lower Tube 

Please Note: The adapter socket should be placed into the lower tube and glued in place. 
 

 

Step 2: Lower Tube 

    
Figure 13: Dimensions of holes for lower tube 
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Please Note: The lower tube requires one bigger hole that serves as an access point/cable hole 
(modelled here with Ø10mm) and a Ø5mm screw hole right across from it. 

 

Step 3: Base Socket 

 
 

Figure 14: Drilled holes for tube socket 

Please Note: The tube socket also needs some drilling to be done, including a large access 
opening matching that of the lower tube (at least Ø15mm). 
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Step 4: Upper Tube 

 
Figure 15: Dimensions of the 3 holes to be drilled in the upper tube 

 
Adjusting tablet mount  

 
Figure 16: Tablet fixation clamp. original clamp (left). CAD-model of the final component (right) 

Please Note: Remove the plastic fixation clamps on the tablet mount as shown in fig. 18 (left 

image), e.g., by breaking them apart with pincers or drilling into them until they break. 

They have to be removed completely, so that only the grooves remain. The final component 

has to look like the model on the right in fig. 20 in order to be properly mounted. 
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Wiring and Soldering 

In the next picture (Fig. 19), you can see the overview of the system with the electrical components, 

which are listed below. The wires between the Arduino and the ESP need to be soldered. The motors 

are soldered to their connecting wires as well. 

 

 
Figure 17: Internal Assembly of the electronic components 

 

●​ The Esp32Cam with WIFI is connecting to the internet and the connection point to the 

remote user. 

●​ The Arduino is getting the motor driving commands from the ESP32Cam through serial 

connection on port 2. 

●​ A powerful motor shield is stacked on the Arduino Board. 

●​ The motor shield drives the two DC motors with integrated gear boxes that provide enough 

torque to propel the robot. 

●​ The Arduino and the driver shield are powered by two power banks, as shown in fig. 20. 

●​ Optional: Additionally, two ultrasonic sensors, one at the back and one at the front, can be 

mounted to warn Telerobi about possible collisions. 
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Figure 18: Internal electronics of the Telerobi 

 

To connect the electronic components follow these steps:  

Step 1: Firstly, the driver shield needs to be stacked physically onto the Arduino. 

Step 2: A cable needs to be soldered to the two contact patches of each DC motor.  

Step 3: The other ends of these connecting cables can be plugged into the connectors on the 

motor shield directly and fastened with the existing screws. Polarity and turn direction of the 

wheels need to be checked when first drive tests are done and might need to be reversed if 

wheels turn the wrong direction.  

Step 4: For the ESP32 three wires need to be soldered between the ESP and the motor shield 

(which is stacked on top of the Arduino). One wire for 5V, one for ground, and the last for serial 

data transmission from the ESP to the motor shield. On the ESP the GPIO1 is used for serial 

output, and on the motor shield/Arduino Port 3 is used for serial input. 

 

Please also refer to the schematic circuit diagram in fig. 21. 
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Figure 19: Connections to form a transistor bridge, Original file, see link in reference [12] 
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 Assembly Stepwise Instructions 
 

 

 

Fig. 20: Explosion view of the Telerobi  
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After finishing all the previous preparations, assembly of the telepresence robot can begin. 
 

1.​ Tube Socket 

Step1: Attach the plastic tube socket to the plexiglass baseplate (300x300mm) using two M3 

screws, washers and nuts. 

Step 2: Make sure that the pre-drilled cable hole (Ø20mm) faces toward the front. 

 

 

 
Fig. 21: Mounting the pipe base 

 

2.​ Add Wooden Support Structure 

Step 1: Place the two 320mm long wooden pieces on the left and right sides of the baseplate. 
Step 2: In both cases, make sure that the pre-drilled holes on the wooden piece and the plate 
align. 
Step 3: Push 4 of the short M8 screws (+added washers) through both pieces, two on each side. 
(Start from the bottom of the plate, so that the screws point upwards through the holes.) 
Step 4: Likewise, push the two longer M8 screws through the rear holes of the wooden pieces, 
also starting from the bottom side.  
Please Note:  Do not add the wing nuts onto the screws yet! 
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Fig. 22: Mounting the pipe base 

 
 

3.​ Insert Lower Tube 

Step 1: Place the lower tube segment (Ø50mm) into the tube socket. Make sure the pre-drilled 

holes on the tube and socket align. 

Step 2: Insert a M3 screw through the hole in the front and place it so that the tip of the screw 

points out of the rear hole. This is best done via an Allen key with a sufficiently long handle. 

Step 3: Put a nut onto the screw from the outside and tighten it to attach the tube to the socket. 

 

  

 

 

 Fig. 23: Mounting the pipe base  
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4.​ Power Banks 

Step 1: Place the two power banks on the baseplate, one on each side of the tube socket. 

Step 2: Make sure that the activation buttons of both power banks point upwards and the 

charger plug-ins point inwards (away from the wooden side pieces). 

 

 

Figure 24: Addition of power banks 

Please Note: The Arduino and DC motors are added in the next steps. The motors pictured here 
are placeholders, not the actual DC motors needed. 

 

 
5.​ Add Arduino and Motors to the base 

 

Step 1: Connect the Arduino’s power inlet to one of the power banks. 

Step 2: Use the double-sided tape to attach the DC-Motors to the baseplate. For optimal 

stability, add four strips of tape to each DC motor housing in a 90-degree angle relative to each 

other. 

Step 3: As shown in fig.23 place the DC-motors directly in front of the wooden side pieces on the 

left and right side, so that the output shafts point outward on both sides and the gearbox cover 

plates on the motors (and their screw heads) do not reach past the rim of the baseplate. They 

should now be taped to both the baseplate and the front face of the wood side bulks, they were 

positioned in front of. 

Step 4: Place the Arduino in between the two motors. Make sure all the wiring is stowed as 

efficiently as possible. 
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Figure 25: Tape strips arrangement around the DC motor housing as well as fixation of the motor 

 

6.​ Add Top Plate 

 

 
Figure 26: Attachment of plexiglas top plate and the tube with wooden support structure 

 

Step 1: Attach the plexiglass top plate (300x400mm) onto the structure. 

Step 2: Slide the tube through the big central hole and lower the plate all the way down onto the 

wooden support structure. 

Step 3: Make sure it is positioned properly, so that the side with the square pattern of pre-drilled 

holes for the swivel castor is located in the back. 

Step 4: Put the connecting cable for the frontal ultrasonic sensor through the pre-drilled hole in 

the plate. 
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The holes on the left and right sides of the top plate should fit with the tips of the M8 screws that 

were attached to the bottom plate and wooden pieces in Step 2). 

Step 5: Now, place the thick washers and wing nuts on the four short M8 screws connecting the 

wooden side structures with both plexiglass plates and tighten the wing nuts. 

Step 6: Make sure that the top plate properly presses onto the tape strips on top of the DC 

motors, so that another fixation for the motors is provided. 

 

 

Figure 27: Motors mounted 

 

 

7.​ Add Front Wood Bulk 

 

Step 1: Insert the 40x40x300mm wood segment with two pre-drilled holes into the front portion 

of the structure. 

Step 2: Make sure the pre-drilled holes align with those of the top and bottom plates and that 

the rear-facing face of the wood piece presses against the remaining tape strips. 

Step 3: Use two M8 screws, washers and wing nuts and fixate them analogous to the previous 

ones. 
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Figure 28: Top view of the structure 

Please Note: The motors pictured are not the actual DC motors used. 

Power banks are not visible here, but should be next to the tube 

socket. 

 

8.​ Add Rear Wooden Bulk 

Step 1: Place the remaining wooden piece (40x40x320mm, 4 pre-drilled holes) on top of the top 

plate. The long M8 screws in the back should now point outward through the two holes closest 

to the sides. 

Step 2: Use the M8 nuts and some washers to fixate the bulk piece. 

Step 3: Make sure that the two central pre-drilled holes correspond to those in the plate. 

 

Please Note: While the screws, tube socket and interior elements are missing in the picture, this 

image gives an overview over the sandwich structure in general. 
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Figure 29: Structure of the rear wooden bulk 

Please Note: The power banks and Arduino are not visible in this image in fig.26, 

although they should be if the assembly was done in the order proposed in this 

document. 

 

 
Figure 30: Structure of the rear wooden bulk 
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9.​ Add Side Covers 

Step 1: Use the two pre-made plexiglass side covers. 

Step 2: Place one of them on the left and right sides of the body structure so that the output 

shafts of the DC motors stick out through the central holes. 

Step 3: Make sure that the curved endings point out of the robot’s front. Now, use SPAX screws 

to screw the side plates onto the wooden bulks. 

 

 

Figure 31: Side Covers 

 

10.​Add the Tube Adapter 

Step 1: Take the sawed-off tube adapter socket and spread multi-component-glue on the entire 

cylindrical outer area. 

Step 2: Stick the adapter socket all the way into the top opening of the lower tube (Ø50mm), 

until only the wider ring segment including the rubber seal ring remains visible. 

 

Please Note: The glue may take some time (approx. 1hr) to harden. Spread glue on the entire side 

area, then insert the adapter piece into the lower tube. 
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Figure 32: Inserting the adapter into the lower tube 

 

11.​Construct the Top Tube Assembly 

Step 1: Attach the tablet mount to the top of the tube piece (Ø40mm). To accomplish this, insert 

2 M5 screws through the pre-drilled holes. 

Step 2: The upper screw can be added through the top opening of the tube, for the lower one 

we recommend using the extra hole that was drilled into the back of the tube element at this 

level. 

Step 3: In the end, attach the tablet mount onto the screws in such a way that one of the screws 

each pierce through one of the grooves on the  tablet mount. 

The specific position of the mount can then be adjusted along these lines based on user 

preference. 

Step 4: The ball joint of the  tablet mount can also be used to adjust the position of the tablet 

later on. Use washers and M5 nuts to tighten the connections. 
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Figure 33: Tablet Mount 

 

12.​Attach the Top Tube 

Once the glue has dried, the top tube can be inserted into the adapter piece. Thanks to the 

rubber seal, the top tube is height-adjustable. 

Please Note: The total height of the DIY Robot can vary in-between approx. 1200 and 1500 mm, 

depending on the adjustment. 
 

13.​Attach the Swivel Castor 

Step 1: Place the swivel castor underneath the square 4-hole-pattern in the top plate. 

Step 2: Push two short M5 screws through the two holes in the front of the castor flange and the 

top plate, starting on the bottom side of the flange. 

Step 3: For the two rear holes, use long M6 screws in the same fashion to connect the flange, 

top plate and the rear wooden bulk. 

Step 4: Use nuts and washers to tighten the castor’s connection. 

 

Please Note: The power banks are not visible in this image, although they should be if the 

assembly was done in the order proposed in this document. 
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Figure 34: Top view of the rear bulk with Castor attached to the underside 

 

 

 
Figure 35: Swivel Castor 
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Figure 36: Swivel Castor 

 

 

14.​Attach Front Wheels 

Step 1: Place the front wheels on the shafts of the motors. 

Step 2: Push them onto the shafts all the way, then use the grub screws to axially secure them. 

Step 3: The wheels have to be attached to the motor shafts. 

Please Note: Since the wheels have a hub diameter of 5mm whereas the output shafts have one 

of 5.5mm, you may have to use a metal drill to widen the hubs on the aluminum wheels. 
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Figure 37: Font wheels attached to the chaises 

 

15.​Finished Product 
Telerobi in comparison to a commercial TPR.  
Aside from the missing power banks and stand-in wheels and motors, all the components pictured 

are part of the actual finalized system in fig.30 
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Figure 38: Final Product – Telerobi besides Ohmni 

 

Option 1: Sound System 
Due to time constraints,  simply attached the loudspeakers to the lower tube with cable ties: 

  

Figure 39: Loudspeakers attached to Telerobi via cables 

If the speaker platform is properly finished (as seen in the CAD imagery), it can also be attached 

to the lower tube via the metal angle fittings. 
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In this case, the speakers can simply be attached to the upper side of the platform via 

double-sided tape. 

 

   

Figure 40: Microphones attached to the tube of telerobi 

 

Finally, the microphone can be attached to the tube as well with a piece of double-sided tape. 
First, remove the smooth cover on the underside of the microphone. 

Then, attach the microphone using a piece of double-sided tape. 

Finally, drill an additional hole (Ø20mm) into the back of the lower tube for the microphone cable 

and speaker power cable. 

Connect the USB plug-in of the speakers to one of the power banks. 

Lead the microphone cable upwards through the entire tube until it comes out on the upper side of 

the top tube. 

Use the dual adapter of the microphone to combine the speaker and microphone cables and insert it 

into the tablet. 

 

Option 2: Ultrasonic Sensors 
Step 1: Add the two ultrasonic sensors (one in the back, one in the front). 

Step 2: Just connect the one in the front to the cable protruding from the hole in the top plate. 

Step 3: For the one in the back, just pull the required connecting cable through the rear of the 

structure and connect that one as well. 

Step 4: Finally, use two SPAX screws each to attach the sensors as pictured below in fig. 34: 

 

Attention: 

1.​ The washers in-between the sensors and the wood are needed in order to prevent the 

Surface-mounted devices (SMDs) on the backside of the sensors from being pressed 

onto the surface, which can damage them and render the sensors useless. 

2.​ We highly recommend using special washers made from plastic (e.g., the model 

https://www.conrad.de/de/p/unterlegscheibe-polyamid-312-teile-838639-838639.html) 
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3.​ The components listed in section 2 can be referred) as they have small diameters and 

pose very little risk of damaging the SMDs themselves, which cannot always be 

guaranteed when using metal washers. 

4.​ If necessary, the cables can be fixed to the plexiglass plates with black isolation tape. 

 

 

          
Figure 41: Attached Ultrasonic sensors. Front (left). Rear (right) 

 

              

   Figure 42: Cables connected to Plexiglas via insulating tapes 

 

Option 3: 3D Printed Wheels 
As an alternative, we used 3D-printed wheels. The disadvantage is that the plastic does not have 

good friction on the floor. For this purpose, a rubber coating can be applied around the wheels. You 

can find the files for 3D printing in the Telerobi Github repository.  
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Telerobi Software Components 
System Architecture 
Figure shows the system modelling of Telerobi, how Telerobi works. 

 

 

 
 

Figure 43: System architecture of Telerobi 

 

Arduino Development Environment 
The Arduino IDE (Integrated Development Environment) is an environment that connects to the 

Arduino and ESP32 boards and allows to upload programs. Arduino IDE is available for all operating 

systems, including Linux, Windows, Mac and Chrome OS. The programming language is C++. 

Download the Arduino IDE and install it. 

 

Telerobi uses two boards: 

-​ Arduino UNO WIFi Rev2, available by default 

-​ AI Thinker ESP32, driver needs to be installed 

 

Install ESP32 Board 
Install the ESP board in the Arduino IDE. For that, go to File -> Preferences and add the link below to 

the Additional Boards Manager URLs and press OK. 

https://raw.githubusercontent.com/espressif/arduino-esp32/gh-pages/package_esp32_index.json 

Then go to Tools -> Boards -> Boards Manager. Search for ‘esp32’ and install. 
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Uploade the Firmware 
Clone the GitHub Repository called Telerobi (https://github.com/Victor-Haefner/telerobi) on your PC. 

The Arduino project files are firmware/esp32/esp32.ino and firmware/arduino/arduino.ino.  

Open the arduino.ino project, connect the Arduino to your PC via USB. Make sure the board, port 

and baud rate are properly configured in Tools > Board > Arduino AVR Boards > Arduino Uno Wifi. 

Finally, upload the Arduino Code, this may take a few moments. 

Open the esp32.ino project, connect the esp32 to your PC via USB. Again, make sure the board 

(ESP32 Arduino > AI Thinker ESP32-CAM) and port are properly configured. Upload the code to the 

ESP. 

After uploading the codes, connect the ESP32 and Arduino to the power sources (the power banks). 

There will be one USB cable from the Arduino which gives power to the motors. The other USB cable 

connected to the main port powers the ESP and Arduino.  

Configure the Robot 
Connect a device, laptop or smartphone, to the WLAN with the SSID named ‘trineBot’. Connect to it 

using the password bot12345. If connecting from a smartphone, you may have to explicitly ask it to 

stay connected because the network does not provide internet access. Once connected, open 

‘192.168.4.1/settings’ on your browser, which is a configuration website: 

●​ Server Address: IPv4 where you will run the server application 

●​ Robot Name: A name, any ASCII string without whitespaces should work, It will be displayed 

on the web interface 

●​ RobotModel: Choose between Telerobi and Elegoo, for this guide set it to Telerobi 

●​ SSID: Set to the local SSID the robot should connect to for internet access 

●​ Password: Give the password used to connect to the local SSID 

Click submit to apply and store the robot configuration. Below the settings, the website also shows 

the status of the robot, the status does not update dynamically, reload the website to get the current 

status. To make the robot reconnect to the server, just reset the ESP board, either by pressing its 

reset button or plug out and in the power supply. 

Server Application 
To be able to control the robot, a server application needs to be hosted on a server, accessible to the 

robot. The easiest way is to set up an Ubuntu server and install Apache with PHP support: 

  sudo apt install apache2 php php-cli libapache2-mod-php 

Clone the Telerobi repository and make sure it is in ~/Projects/web/trine. The path is currently not 

configurable, you can change it in the ESP firmware if necessary. 

  mkdir -p ~/Projects/web 

  git clone https://github.com/Victor-Haefner/telerobi.git ~/Projects/web/trine 

Create a symbolic link to make the project visible through apache: 

  sudo ln -s ~/Projects/web /var/www/html/web 
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Try connecting to the website with http://localhost/web/trine . If you get an error 403 you can try: 

●​ Fix permissions in your home directory, the line below will recursively set all permissions: 

​   sudo chmod 755 /home/$USER 

●​ add the user to www-data group (restart the server to take effect) 

  ​   sudo adduser $USER www-data 

Drive the Robot 
Open the website SERVERADDRESS/web/trine in your browser. This is the website to manage and 

control your robots, reset the robot if it does not appear in the list. The left side column lists the 

robots registered on the server. At the bottom of this page you can see basic commands which you 

can use to control the movement of your robot and also turn the camera on and off.  
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Conclusion and Future work 

While the current version of the DIY telepresence robot kit provides a good starting point for building 

your own robot, there are still many possibilities for future development and improvements. For 

instance, one could explore ways to improve the robot's stability and maneuverability or add 

additional features, such as sensors for navigation or object recognition. The graphical user interface 

could also be optimized and made more suitable for the specific target group. Currently, the robot 

uses a tablet for sound input and output; a microphone array and speakers could be added. For a 

better connection to the local wifi, we recommend installing an additional antenna on the ESP board. 

Additionally, the kit could be adapted for different use cases, such as remote inspections in industrial 

settings. 

Overall, the DIY kit for telepresence robots offers a cost-effective and educational way for individuals 

and organizations to create their own robots. With the detailed guidelines provided in the document, 

anyone can follow along and create their own telepresence robot from scratch. 
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Additional Images:  
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